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About This Guide

About This Guide

The Yealink video conferencing  systems provide an APl interface for the Crestron R
3-Series control system s. The interface allows you to control the Yealink video
conferencing system through the touch panels installed in the control device.

When you successfully deploy environment and configure  the Crestron iR 3-Series
control systems, the Yealink video conferencing systems and the control devices , you
can remotely manage certain features of your video co nferencing system via the control

device.

Crestron 3-Series Control Systems

The following table lists the  produ cts included in the Crestron R 3-Series control

systems.
AV3 3-Series Control Systemfr
CP3 3-Series Control System R
CP3N 3-Series Control System R
MC3 3-Series Control SystemmR w/infiNET EXIR
PRO3 3-Series Control Systemfr
RMC3 3-Seriesfk  Room Media Controller

In This Guide

Topics provided in this guide include:

Chapter 1 Deployment Environment
Chapter 2 Debugg ing Process
Chapter 3  Yealink VCS Panel Pages Overview

Chapter 4  Frequently Asked Questions
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Deployment Environment

Deployment Environment

This chapter introduces the deployment environment , which instructs you to connect
control and accessibility equipment . The Yealink video conferencing systems  support
TCP/IP connection and RS-232 connection . Note that if you connect the Crestron rr
3-Series control system to the Yealink video conferencing system through TCP/IP
connection , the Crestron frR 3-Series control system, the Yealink video conferencing

system and the control device should be in the same network segment. Topics include :

Hardware Deployment

Software Program s

Hardware Deployment

Hardware Devices

Yealink video conferencing  systems (built-in API interface , firmware version
X.21.0.10 or later)

=T
s

A display device
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The control device s (PC, iPad, etc. )

(Taking a PC and an iPad for example )

The Crestron iR  3-Series control systems

(Taking CrestronfR MC3 for example )

Ethernet cable

A router (applying to TCP/IP connection)

wlalwlsls]s]s

A USB to RS-232 cable (applying to RS-232 connection)

|§

O nﬂ

Hardware Connection

The Yealink video conferencing systems  support TCP/IP connection and RS -232

connection.



Deployment Environment

TCP/IP Connection

TCP/IP connection is displayed as below:

[ —— }
— N
- 7
Y CRESTRON
RS-232 Connection
RS-232 connection is displayed as below:
COM 1

Yealink

T CRESTRON

/_
(=)
_

Software Programs

The software program s contain Crestron software, Crestron configuration program s and

the control device configuration program S.
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Crestron Software

Crestron software mainly refers to Crestron Toolbox . It is used to import the
corresponding configuration program into the Crestron frR 3-Series control system and
the control device.

1 » Yealink » Crestron Software

E - =
= M HER £ o
ﬁ%’ crestron_database_55.00.011.00.exe 2016/4/10 15:42 RIFHTER 170,483 KB
|T_EE—J crestron_toolbox_2.41.418.00.exe 201674710 15:41 79,757 KB
ﬁl device_database 73.05.002.00.exe 2016/4/10 15:42 RARER 211,679 KB

Crestron Configuration Programs

Crestron provides two kinds of modules as the configuration program s. The modules
contain a TCP/IP module and a RS232 module. The selection of modules is depending

on connection methods you use

1 » Yealink » Modules »

v =
=iF EMHE i |
__w [fyou use TCP/IP connection, you should import IP module.
JIP 2016/5/16 15:46
« RS232 2016/5/16 15:46 T

" |f you use serial connection, you should import R5232 module.

Only one of these co nnection methods can be used  at once.

TCP/IP Module

If you connect the Crestron iR 3-Series control system to Yealink video conferencing
system through TCP/IP connection , you should use TCPAP module. And the IP address of
Yealink video conferencing  system should be written in the configuratio  n file.

» Yealink » Modules » IP - |¢7|
r i =
=5 EXERE =3 o
|| Yealink VC Series Demo IP CP3{192.168.11.2}Ip= 2016/5/4 17:45 LPZ 3% 750 KB
|| Yealink WC Series Demo IP CP3(192.168.11.2).sig 2016/5/4 1745 SIG 3Tt 57 KB
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Only a n .Ipz file requ ires importing into the Crestron iR 3-Series control system.

RS-232 Module

If you connect the Crestron iR 3-Series control system to Yealink video conferencing
system through the RS-232 connection, you should use RS -232 module and connect the
RS232 serial portin Crestron iR 3-Series control system to the USB port in your video
conferencing system codec through a USB to RS-232 cable . Only an .Ipz file requires
importing into Crestron rR 3-Series control system.

v Yealink » Modules » RS5232

I s

£ EN

| ¥ealink VC Series Demo R5232 CP3.lpz 750 KB
_| ¥ealink VC Series Demo RS232 CP3.sig 57 KB

RS-232 serial portin Crestron iR MC3:

INPUT
126G

(HE

— NET— 24VDC
HYZGO

Control Device Configuration Programs

Contr ol device configuration program s mainly refer to touch p a n e tosfiuration

programs . The touch panels are install ed in the control device.

The following table lists the configuration programs required in a PC and an iPad

Crestron XPanel application and .c3p file .

PC For more information, please refer to Installing

Touch Panels in a PCon page 13.

iPad Crestron for iPad application and  .xml file .
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For more information, please refer  to Installing
Touch Panels in an iPad on page 15.

For more information about the  software programs required in  other control devices,
please contact Crestron .



Debugging Process

Debugging Process

This chapter provides the debugging process. The TCP/IP connection is introduced for
example. Topics include :

Install ing Crestron Toolbox
Importing Crestron Modules

Install ing Touch Panels

Installing Crestron Toolbox

To install Crestron toolbox inaPC:

1. Double -click Crestron toolbox application.

:} » Yealink » Crestron Software

1

2 TR

138

TE;’ crestron_database_55.00.011.00.exe
|TLEJ-| crestron_toolbox_2.41.418.00.exe
LE;’ device_database_73.05.002.00.exe

The Crestron Toolbox Setup Wizard is displayed as below:

18] Setup - Crestron Toc n 241418.00
Crestron Toolbox version 2.41.418.00

lbox vers

=

Welcome to the Crestron Toolbox
version 2.41.418.00 Setup Wizard

2. Follow s the default installation process
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Importing Crestron Modules

Importing a TCPAP module into the Crestron R 3-Series control system is introduced for

an example .
To imp ort modules by Crestron toolbox

1. Double -click Crestron toolbox application icon .
2. Click on View -> System Info .

3. Click .
4,

Mark the radio box of TCP.

Edit Address @

Connection Type:

@ TCP (TVR5232 (T USE O Indirect
IP Addrezs / Hosthame: 192.162.11.23 -
Auto Detect -
» Advanced

» Advanced Device Detection

.ﬁ.ddressEnnk...] [ ] 8 l [ Cancel




Debugging Process

5. Enter the IP address of the Crestron iR 3-Series control system in IP

Address /Hosthame field.

Edit Address @

Connection Type:
@ TCF RS232 LSE [ndirect

IF &ddrezs / Hostname: 192.168.11.23 -

Auta Detect -

» Advanced

» Advanced Device Detection

.-'-‘u:ldressEnn:uk...| [ (] l | Cancel

6. Click OK.

If the Crestron toolbox connects to  the Crestron iR 3-Series control system

successfully, the page will be shown as below:

@ DefaultWorkspace.ctw - Crestron Toolbox - [System Info - auto 192.168.11.23] o= =
I Fle View Tools Window Help SystemInfo Functions

S| X @ @S A M ERED

: Fifrash 76y | Status: Retieval Completz.

= Frogram L]

Device Hame: MC3 MinimmumCUZ - A
Version: 1.0700060 TargesRack : AV3
Serial Humber : ProgramBootDir : \SIMPL\app0l
Category: Contral Systern SourceFile : C:\Users\David\Dropbox\Crestron\Modules\Prod:
ProgramFile : Yealink VC Series Demo IP CP3_smw
= Display Praject (]3] -

« M v
No project loaded.
= Ethemet e m
Link: ®
IP Address: 192.168.11.23
IP Mask: 255.256.285.0
Hegatiation: Auta
MAC Address 00.10.71.2e 56.a2

® _Cresnst Devices 8 Def Router: 132168111

S Intemal Memory Lssns an Hostname:  Huddle Fim2
Domain Mame:  not available

149.0MB of 1831.0 MB used. DHCP: Enabled

S5L: Disabled (Selisigned]
Program : 2236.5KB
SPLUS : 2236 6KB DMNS Servers: 192,168.11.1[dynamic]
Web Pages: 234 ME
Display List: 2801 KB
Reclaimable : O bytes

S System Clock L0
Time / Date: 503:25516:2018 2 Erotos 80
ime / Dale 125 516
Spstem Uptime - 0 day(s], 3:23:34.00 = iﬁmTlacl‘Flash UAsage IO

- A Connected.  [auto 192.168.11.23

Ready
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7. Dragthe vertical scroll bar to the middle position.

@ DefaultWorkspace.ctw - Crestron Toolbex - [System Info - auto 192.168.11.23]

[E=RE=R>"
I Fle View Tools Window Help SystemInfo Functions =)=
FHExmB oy IEARRMED

S Produst Info[03)

Desice Mame: MC3-Module-0S
Wersion: 1.010.0060
Serial Number
Category: Firmware Module

S Produst InfofUpdater]
Device Name: MC3Module UFDATER
Wersion: 1.000.0027
Serial Number
Categay: Fimware Module

S ProgramiPrograml) BB | B IPTablelProgim0l)

am
Vinimmcuz - ~ | TP  Address Envry Type Dev ID Port  Commecvion T4 |1
TargetRack : AV3 a3 127.000.000.001 slave 41794 gway
ProgramBootDir : \SIMPL\appOl 04 127.000.000.001 slave oo 41794 gway
SourceFile : C:\Users\David\Dropbox\Crestron\Modules\Produ
ProgramFile : Yealink VC Series Demo IP CP3.smw
« n v « M v
2 Fimware Capabilties[Programd1) 2] = Hardware InfolProgramil1) a
Category: Contrel System - Current Hardware Configuration -
SIMPL: Level 1 Drocessor Type: MC3
SIMPL+: Level 1 Hum YBus Slots: o
Displaylist: HOT SUEBRORTED Hum ZBus Slots: 1
Web Server: Enabled: Level 1 1: CZI-MC3CNET-1 Cresnet
. f « ) |
- @ Connected auto 192.168.11.23
Ready

8. Click .

= Program([Programl]

230

MinimmmClOZ - -
TargetBack : AV3

ProgramBootDir : “SIMPL\appOl
SourceFile : C:WUsersh\David\Dropbox'Crestron'ModuleshProdu
ProgramFile : Yealink WC Series Demo IP CP3.smw

4 L1

9. Click Browse....

5 SIMPL Program (Program01) - auto 192.168.11.23

Frograml &%)

Send and Retrieve Program To/From

@) |nternal Flazh Compact Flazh

Current Program
Program Information:

MinirmurmCUZ: -
TargetRack: 443

ProgramB ootDir: YSIMPLapp01

SourceFile: C:\Jsers\David\DropbosiCrestronih odules\ Productiony'ealink \Demo
WPYYealink W Series Demo IP CP3

ProgramFile: vealink YT Series Demo P CP3.smw

Stop | | Restart | | Eraze | | Retrigve

Send Program
FAWCS-CRESTRON Y ealink \Modulesh Phvealink WC Series Dema | -

Minimum Program Requirements:

MinimumCUZ: 1.007.0017 -
TargetRack: 443

MYRAMProglsage: 0

BinFileMame: vealink T Senies Dema IP CP3.bin

RouteFileM ame: Yealink W Series Demo |P CP3rte

Bypass auto start/stop of dependent programs
Send 51G File

Always zend default IP table without azking
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10. According to the TCP/IPconnection method, s elect an .lpz file.

* Eapis

@@v| v HEHL » FEI (R » Yealink » Modules »

HE ~ g

& BF -

|'r&\

M HEA
& ()
ca B (D)
= LE(E)
ca T3 (R)
o CD ¥ (G)
¥ 81

; R§232

m

€ s

v A 1

»

IEE(N): Yealink WC Series Demo IP CP3(192.168.11.2).If - |SIMPL Windows Files (*Ipz) v|

[HiFF(D] H B ‘

11. Click Send.

5 SIMPL Program (Program01) - auto 192.168.11.23

Frograml &%)

Send and Retrieve Program To/From

@ Internal Flash Compact Flazh

Current Program
Program Information:
MinirmurmCUZ:

TargetRack: 443
ProgramB ootDir: YSIMPLapp01

WPYYealink W Series Demo IP CP3
ProgramFile: vealink YT Series Demo P CP3.smw

SourceFile: C:\Jsers\David\DropbosiCrestronih odules\ Productiony'ealink \Demo

Stop | | Restart | | Eraze...

Rietrieve...

Send Program

Minimum Program Requirements:

MinimurCUZ: 1.007.0017

TargetRack: 443

MYRAMProglsage: 0

BinFileMame: vealink T Senies Dema IP CP3.bin
FouteFileM ame: Yealink VT Seres Demo IP CP31te

Bypass auto start/stop of dependent programs
Send 51G File
Always zend default IP table without azking

FAWCS-CRESTRON Y ealink \Modulesh Phvealink WC Series Dema | - Browse...

Close

11
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Please wait a few minutes.

After the dialog box disappears
finished.

, the send process is

& SIMPL Program (Program01) - auto 192.168.11.23
Frogram 4]

Send and Retrieve Program To/From

@ Intemnal Flash _) Compact Flash
Current Program
Program Information:

MinimumCUZ, i
TargetRack: {Please Wait...

ProgramBoot]
Faurcefile: C
P Tealink Stopping the program...
ProgramFile:

Stop

Send Program

Retrieve...
F:hvealink b

Browse...
Minirurm Prog| Cancel
MinirurnCLL

TargetRack: AY3

MYRAMProgllzage: 0

BinFileMame: “vealink ¥C Seies Dema [P CP3.bin
RouteFilet ame: ealink W Series Demao IP CP3.rte

Frogram Stop k\Dema

[] Bypas: auto start/stop of dependent programs
[] Send 515G File

Send
[ Ahways send default IP table without asking
Cloze

Installing Touch Panels

You can remotely control the Yealink video conferencing system through the touch
panels installed in the control device (PC, iPad, etc.) .

This section introduces the following

Install ing touch panel sinaPC

Installing touch panels in an iPad

If you open the touch panel

sina PCand inaniPad synchronously , whatever operation s
you do on the touch panel

sinaPC or aniPad , their touch panels change synchronously
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Installing Touch Panels in a PC

To install touch panel sin a PC:

1. Double -click Crestron XPanel application

» Yealink » touchpanels » xpanel » Yealink VC Series Demo_XPANEL_EXE.c3prj

=R EEE e Fh

[ CrestronXPanel installer.air 2016/2/12 14:46 Installer Package 1,881 KB

[ CrestronXPanel installer.exe 2016/2/12 14:46  REERF 2,175 KB|
| Yealink VC Series Demo_XPANEL_EXE.c3p 2016/5/16 10:38 c3p 19,847 KB

The Crestron XPanel Setup Wizard is displayed as below:

AR o] = ==

Crestron XPanel

iHEA
¥Pansl sllows the Loading of a Crestron certified

SmartGraphics touch sereen project to be loaded on a
desktop computer.

TREESH
V] iSRRI S E
[V] EH# BB RER

FRHE:

|c:\Prognm Files\CrestroniiFansl |

2. Follows the default installation process

3. After installation, double -click Crestron XPanel icon .

13
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4. Click on File-> Load Project .

-1 Crestron XPanel
Options  Help
Load Project Ctrl+O

Reconnect Ctrl+5

Exit

5. Select .c3p file and click Open .

el » Yealink VC Series_XPAMEL_EXE.c3prj

T

13
1t

=

Yealink VC Series_XPANEL_EXE.c3p

m

FAE=(N): Yealink VIC Series_XPANEL_EXE.c3p

== il (7]
M s
2016/5/16 10:38 Crestro
r
- [mEaes |
| a0 || mw |
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6. Afteryou enter the touch panel sin PC, touch Setting s to navigate to the Setting s

page .

Settings
Manual Call Settings Version Information

Speed: Auto 768 1024 Model: Yealink VC120
Firmware: 40.20.254.84

Type: Auto Video Audio Hardware: 40.7.5.1.0.0.6
Product ID: 201605170958
Protocol: Auto CC Version: 1.0.0.1

Module Status Storage

Is Communicating .

Is Initialized

Reinitialize

g m o5

Dialing Address Camera IR History
Book Input Select Emulation

You can view the version information normally, it means the touch panel sin a PCare

installed successfully .

Installing Touch Panels in an iPad

To install touch panels in aniPad :

1. From the Apple App Store, search for Crestron for iPad and download the
application .

2. InaniPad,t ouch the icon to enter the Crestron for iPad

3. Touch UPGRADEo buy the usage right of Crestron for iPad .

4. Touch - .

15
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5. Youwill enterthe EditLocation screen, editthe name inthe Friendly Name/Location
filed.

Edit Location

Friendly Name

/ Location Yealink VC120

Use Local Project

ad

Host name or
IP Address

HTTP Port

192.168.11.23

IP ID

cip

y Internet/Mobile)
Host name or
IP Address
HTTP Port

cip

Enabled

Enable SSL

User Name

o

6. Swipe the Use Local Project switch rightto ON.

7. Enter the IP address of the Crestron iR 3-Series control system in Hostname or IP
Address field .

Edit Location

Address 1 (Typicall

Friendly Name

/ Location Yealink VC120

Use Local Project

Host name or
IP Address

HTTP Port

192.168.11.23

IPID

ally Internet/Mobile)

Host name or
IP Address

HTTP Port

cip

Enabled

Enable SSL

User Name

o

8. Enter 04 in IP ID filed.

16
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10.
11.
12.
13.

Touch Save.

Double -click Crestron toolbox application icon inaPC.

Click on View -> System Info .

Click [%].

Mark the radio box of TCP.

Edit Address @
Conpection Type:
@ TCP RS232 UsSE [ndirect
IP Addrezs / Hoztname: 192.162.11.193
Auto Detect

» Advanced
» Advanced Device Detection

Addrezs Book... | [ k. l | Cancel

17
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14. Enter the IP address of the

iPad in IP Address /Hostname field.

Edit Address
Connection Type:
@ TCP R5232

2 sl

LSB [ndirect

IF &ddrezs / Hosthame:

192168.11.199

» Bdvanced

dauto Detect

» Advanced Device Detection

Addreszs Book, .. I l OE, I l Cancel
15. Click OK.
If the Crestron toolbox connects to  iPad successfully, the page will be shown as
below:

[W DefauitWorkspace.ctur - Crestron Toolbox - [System Info - auto 192.168.11.199]

FHxm @S ITHKRHAREDT

* [ R s | S12ue: Relveval Congiele

GITM = O Pocc: E
Sisplayiistrile - Yealink 3Ve_Zosaries 2ucems TPAD. 2ip
: oariiszate 1352
Zax
[3] - (%) (& Connecled  aun 15216311159
12. Click [
= Dizplay Project 2] E

DisplayListFile
CompiledOn :
TargetPanel :
ENGRegquired :
TargetProducts :

04/11/2016 13:32

: Yealink Z20VC Z0Series_Z0Demo IPAD zip

Connected.

auto 192.168.11.133

18
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13. Click Browse....

K Project - auto 192.168.11.199 ¥ =
Loaded Praject Infarmation Selected Praject Information:
DisplayList File: Yealink_20WC_205eries 2( »  DisplayList File: Yealink_20WC_20Series_2[ »
Compiled Or: 04/11/2016 12:32 Compiled Or: 04/11/2016 1332
Target Panel: Target Panel
PMG Required: | PMG Requied i
Target Products: 3 Target Products: 3
Project Type: Crestron Mobile Project Type:
Language Pack Required: Language Pack Required
Min Core3 Ul Level: Min Cored Ul Level:
Project Platform: - Pioject Platfarm: -

g T v B m b
Remote Project Directory.  Nat applicable to this device
Send Madified Files Only

Aillowy improved anti-aliazed fonts [16-Level] to load.

Project File:

F:\ealink touchpanelshiPadsyealink VT Series Demo_PADL - | Browss... Send
Initialize Feboot Cloze

14. Select .xml file and click Open .

» Yealink VC Series Demo_IPAD.Core3 - ‘ 4 ‘ |

>
1

=

2 Yealink VC_Series_Demo_IPAD_Manifest.xml

~ | I r

FHE(N): Vealink VC_Series Demo_[PAD Manifestsm| = [Bi&STiSC2) -

[0 | [ = |

19
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15. Click Send.
5] Project - auto 192.168.11.199 [ =]
Loaded Project Information: Selected Project Information:
DisplayList File: Yealink_20WC_205eries 20 »  DisplayList File: Yealink_200C_205eries_2[ »
Compiled On: 0441172016 13:32 Compiled On: 04/11/201613:32
Taiget Panel: Target Panel:
PMG Requied: _| PMNG Required: L
Target Products: = Target Products: 3
Project Type: Crestron Mobile Project Type:
Language Pack Required Language Pack Required:
Min Core3 Ul Lewvel: ~ MinCore3 Ul Level:
Project Platform: ~  Project Platfom: -

Remote Project Directory: Mot applicable to this device

Send Modified Files Only

Allows impraved anti-aliazed fonts [16-Level] to load.

Project File:

F:iealink\touchpanelshiPadyyealink, VT Series Demo_PAD.L +
Initialize Feboat

16. Touch the name you editin the Friendly Name/Location filed in aniPad .

17. After you enter the touch panels,t ouch Setting s to navigate to the Setting s page .

Settings
Manual Call Settings Version Information

Speed: Auto 768 1024 Model: Yealink VC120
Firmware: 40.20.254.84

Type: Auto Video Audio Hardware: 40.7.5.1.0.0.6
Product ID: 201605170958
Protocol: = Auto CC Version: 1.0.0.1

Module Status Storage
- Is Communicating .

-~

Is Initialized

Reinitialize

IR o)

Dialing Address Camera IR History
Book Input Select Emulation

If you can view the version information normally, it means the touch panel sin an

iPad are installed successfully .



Yealink VCS Panel Pages Overview

Every page in touch panel sincludes a menu for navigatingto  a different page. Many of
the pages in touch panel s also include buttons for increasing or decreasing the volume

and muting the microphone . This chapter provides instructions for the  Yealink VCS panel
pages overview . The touch panels in aniPad are introduced for example . Topics
include :

Yealink Logo Page
Dialing Page
Address Book Page
Camera Page

Input Select Page
IR Emulation Page
History Page

Setting s Page

21













































